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1. Set up Weight and Balance Management
To create a high-quality product, managing the weight and balance of a product is very important. In
the industries such as aerospace, automotive, and construction, weight and balance properties directly
impact product efficiency, performance, stability, and movability.

Using the Weight and Balance Management application in Teamcenter, companies can manage the
weight and balance properties of their product right from the concept through the service phases. They
can integrate weight and balance data into the overall product development process to ensure that
products meet performance, safety, and regulatory requirements.

You, as an administrator, must set up Weight and Balance Management so that weight engineers can set
their weight targets and generate rollup reports.

Where do I go from here?

 Business User

How can I manage weight and balance rollup
data?

See Weight and Balance Management ─
Usage.

 Administrator

How can I install Weight and Balance
Management?

See Install Weight and Balance Management.

How can I set up Weight and Balance
Management?

See Task flow to set up Weight and Balance
Management.

Where can I get a list of preferences that I need
to set for Weight and Balance Management?

There are several sources from which you can
retrieve a list of preferences. You can view the
list in the Administration Data Documentation,
Teamcenter rich client, Active Workspace, and
raw XML file.

The preferences that are specifically used for
Weight and Balance Management start with the
prefix WNB.
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1. Set up Weight and Balance Management
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2. Task flow to deploy and administer
Weight and Balance Management
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2. Task flow to deploy and administer Weight and Balance Management
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3. Install Weight and Balance Management
using Teamcenter Environment Manager
(TEM)
Add the Weight and Balance Management and Active Workspace Weight and Balance Management
applications to you existing Teamcenter environment.

Adding applications is described in the Teamcenter server installation guides for Windows and Linux.

Prerequisites

• Verify that Parameter Management is installed. It is required only to set weight targets if you choose
to migrate to the new data model. If you choose to retain the old data model, Parameter Management
is required for setting both weight types and weight targets.

• If you want to run the rollup calculation in the background (asynchronously), you must install
Teamcenter Dispatcher. For more information, see Installing and Configuring Dispatcher.

You must also configure the AsyncService translator. For more information, see Enable the
AsyncService translator.

Procedure

Update your Teamcenter setup to install the following applications through TEM:

• Extensions > Weight and Balance Management

• Extensions > Active Workspace Weight and Balance Management

• Base Install > Active Workspace > Client > Active Workspace Weight and Balance Management
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3. Install Weight and Balance Management using Teamcenter Environment Manager (TEM)
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4. Install Weight and Balance Management
using Deployment Center (DC)
Add Weight and Balance Management to your existing Teamcenter environment through a series of
tasks from selecting the application and entering configuration parameters to generating and running
deployment scripts.

Prerequisites

Weight and Balance Management requires the Parameter Management capability to set different weight
types.

If you want to run the rollup calculation in the background (asynchronously), you must install
Teamcenter Dispatcher. For more information, see Installing and Configuring Dispatcher.

You must also configure the AsyncService translator. For more information, see Enable the
AsyncService translator.

Procedure

1. Log on to Deployment Center and select the environment to which you want to add Weight and
Balance Management.

2. Go to the Applications tab. Click Add or Remove Selected Applications .

3. In the Available Applications panel, use the web browser search to find the Weight and Balance
Management application. Select the application, and then click Update Selected Applications.

Deployment Center automatically selects any additional dependent applications.

4. Go to the Components tab.

5. In the Selected Components list, note any remaining components whose configuration status is
not 100%. Select each incomplete component, enter required parameters, and save component
settings until all components in the environment show a configuration status of 100%.

When all components are fully configured, the Deploy tab is enabled.

6. Go to the Deploy tab. Click Generate Install Scripts to generate deployment scripts you will use to
update affected machines.

When script generation is complete, note any special instructions in the Deploy Instructions panel.
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7. Locate deployment scripts, copy each script to its target machine, and then run each script on its
target machine.

For more information about running deployment scripts, see Deployment Center ─ Usage.

4. Install Weight and Balance Management using Deployment Center (DC)
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5. Migrate weight and balance data from
the old data model to the new data model
A new data model is available that is independent of the CAD tool being used. The new data model
is not dependent on parameters. Therefore, with the new data model, you do not need to install
Parameter Management to set the weight types. You need it only to set the weight targets.

If you are doing a fresh installation of Weight and Balance Management, you are working with the new
data model by default. However, if you have an existing installation of Weight and Balance Management
and have data in the old data model, you need to run a migration utility so that the data is migrated to
the new data model.

After the migration is successful and you are ready to switch to the new data model, you must set
the value of the WNB0_EnableCADBidirectionalExchange preference to True so that you can work
with the new data model. After that, a bidirectional exchange of data can proceed between the CAD
application and Teamcenter.

Restrictions and limitations

This utility updates only the data that is local to a database. It does not update replicated data.
Therefore, in the case of a multi-site scenario, you must update and then refresh the replicated data.

The information from the old data model is migrated to the new data model, but the new LOV is not
updated. For example, if the information about the External weight type is present in the Att0Source
LOV in the old data model, it is migrated to the new data model, but the Wnb0MethodTypeValues
LOV is not updated with the External entry. Therefore, to display this information in the GUI, you must
manually update the Wnb0MethodTypeValues LOV. Teamcenter checks if an LOV value in Att0Source
is also available in Wnb0MethodTypeValues. If it is not available, a warning message is displayed in the
utility report.

Procedure

1. Install Weight and Balance Management.

2. Run the following utility in the Teamcenter command prompt to migrate weight and balance data
from the old data model to the new data model:

wnb_migrate_parameter_data -u=user_id {-p=password} -g=group
-report=absolute_path_to_fileName

Tip:

For more information about this utility, see its help:
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wnb_migrate_parameter_data -h

Results

After the data is migrated, a migration report is populated in a file with the name that you
specified in the -report argument of the wnb_migrate_parameter_data utility. If you did not
specify a location in the -report argument, the report is available in the folder where you ran the
wnb_migrate_parameter_data utility.

5. Migrate weight and balance data from the old data model to the new data model
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6. Set a BMIDE template project
to configure Weight and Balance
Management
You can manage the extensions and configurations for Weight and Balance Management within a
Business Modeler IDE (BMIDE) template project.

Procedure

1. Create a new BMIDE template project.

2. Add the following Weight and Balance Management templates to this project:

• wnb0weightandbalance

• wnb1weightandbalanceaw

3. Within this template project, perform the required configurations, such as defining custom weight
types and enabling search and workflow submission for payload, CG envelope, and payload
collection data.

4. Deploy the template project.

5. Verify if Weight and Balance Management is configured correctly.
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6. Set a BMIDE template project to configure Weight and Balance Management
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7. Define custom weight types
You can add custom weight types to the list of weight types displayed for structures. Some default
weight types are used in rollup calculations, for example, Actual, Asserted, and Estimated. Based on
your business requirements, you can add custom weight types for rollup calculations.

To add custom weight types:

1. In BMIDE, open the required BMIDE template project, for example, OT45.

2. Open the Wnb0MethodTypeValues LOV.

3. Click Add.

4. In the Create dialog box, enter a value and description for the custom weight type, and then click
Finish.

5. Add the custom weight type to the WNB0_MassMaturitySequence preference for specifying the
precedence.

Any value that is not included in this preference is not considered for rollup.
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The following image shows some sample values for the WNB0_MassMaturitySequence
preference:

6. To display the custom weight type on the UI, modify the column configuration file:

a. Open the column configuration XML file, Wnb1ContentTableUiConfigCots.xml, which is
located at:

TC_ROOT\install\wnb1weightandbalanceaw\data

b. Copy the Wnb1ContentTableUiConfigCots.xml file to the C:\Temp directory and add the
custom weight type to ColumnDef objectType in the file.

The following example shows the format for the Actual weight type.

<ColumnDef objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Actual" width="100" hidden="true"/>

Similarly, for the weight type CustomWeightType, add the property name as follows:

propertyName="wnb0_bl_CustomWeightType"

Here, propertyName is the internal name of your LOV value.

c. Import the column configuration for the group and role as required.

The following example shows the column configuration import command for the Weight
Analyst role:

import_uiconfig -u= -p= -g=dba -for_group=Engineering, 
-for_role=Weight_Analyst -file=c:\temp\rollup_column_config.xml

7. Define custom weight types
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You can use Business Modeler IDE to set the display name for your custom objects and to override the
display names of the out-of-the-box Teamcenter objects. For information about renaming the columns
inside of the BOM view, see Set display names for properties.

Caution:

If you want to remove a weight type, you must delete it from BMIDE, from the the column
configuration, and from the preferences in which the weight type is added.
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7. Define custom weight types
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8. Enable search and workflow submission
for payload, CG envelope, and payload
collection data
To generate excursion charts, Teamcenter uses the Wnb0Payload, Wnb0CGEnvelope, and
Wnb0PayloadCollection business objects.

The data represented by the Wnb0Payload and Wnb0CGEnvelope business objects is not searchable,
by default. Therefore, you need to make this data searchable.

You also need to enable the submit to workflow command for the Wnb0Payload, Wnb0CGEnvelope,
and Wnb0PayloadCollection business objects.

Procedure

1. In BMIDE, open the required BMIDE template project, for example, OT45.

2. Open the Wnb0Payload business object.

3. Do the following:

• To make the data represented by the Wnb0Payload business object searchable, on the Business
Object Constants tab, select Awp0SearchIsIndexed and then click Edit.

• To enable the Submit to Workflow command for the Wnb0Payload business object, on the
Business Object Constants tab, select Awp0WorkflowSubmittable and then click Edit.
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4. In the Modify Business Object Constant dialog box, select True for Awp0SearchIsIndexed and
then click Finish.

8. Enable search and workflow submission for payload, CG envelope, and payload collection data
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Similarly, for Awp0WorkflowSubmittable, select True and then click Finish.

5. Similarly, follow the steps 2 through 4 for the Wnb0CGEnvelope and Wnb0PayloadCollection
business objects.
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8. Enable search and workflow submission for payload, CG envelope, and payload collection data
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9. Prevent double accounting while rolling
up structures with partitions
A structure element can belong to more than one partition within a partition scheme. In this
case, when users try to perform mass rollup calculation, that element is considered more than
one time. To prevent this double accounting, you, as an administrator, must set the value of the
Ptn0IsMultipleBomlineMembershipAllowedInScheme business object constant to false in Business
Modeler IDE (BMIDE). The default value of this business object constant is True. Setting the value of this
business object constant to False ensures that an element is added only to a single partition within a
scheme.

If a user has already added an element to more than one partition and then you set the value of
the business object constant to False, the user must manually unassign the element from the other
partitions, so that double accounting does not happen.
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9. Prevent double accounting while rolling up structures with partitions
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10. Verify if Weight and Balance
Management is configured correctly
You can verify if Weight and Balance Management is configured correctly by performing certain steps,
such as updating the column arrangement with mass and balance columns, adding or updating values
for any editable weight types, and calculating mass rollup for a structure.

Procedure

1. Open a structure in Active Workspace. The weight and balance columns are hidden by default. To
add the weight and balance columns:

a. Click  to the right of the column headings to display the Arrange panel.

b. Click Column Arrangements and then from the list, select Mass and Balance.

c. Click Arrange.

2. Add or update the values for the Budget, Estimated, or any other editable weight types for the
structure.

If CAD data is available for the assembly, From Design, Center of Mass, and Moments of Inertia
and Products of Inertia properties are auto-populated.

3. (Optional) If you want to display additional columns such as Center of Mass, Moments of Inertia,
and Products of Inertia, add the attributes for their properties to the column configuration input
file. The following examples show the format:

<ColumnDef columnName="wnb0_bl_Asserted_CoMX" filterable="true" 
hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_CoMX" width="300"/> 
<ColumnDef columnName="wnb0_bl_Asserted_CoMY" filterable="true" 
hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_CoMY" width="300"/> 
<ColumnDef columnName="wnb0_bl_Asserted_CoMZ" filterable="true" 
hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_CoMZ" width="300"/> 

<ColumnDef columnName="wnb0_bl_Asserted_PoIXY" filterable="true" 
hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_PoIXY" width="300"/> 
<ColumnDef columnName="wnb0_bl_Asserted_PoIXZ" filterable="true" 
hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_PoIXZ" width="300"/> 
<ColumnDef columnName="wnb0_bl_Asserted_PoIYZ" filterable="true" 
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hidden="false" objectType="Awb0ConditionalElement" 
propertyName="wnb0_bl_Asserted_PoIYZ" width="300"/>

Verify if the additional columns that you have added are displayed on the user interface.

4. Calculate the mass rollup for the structure.

5. View the existing rollup reports.

6. Verify the rolled up values.

10. Verify if Weight and Balance Management is configured correctly
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11. Configure the columns to be displayed
and their arrangement in a rollup report
A business user can generate weight and balance rollup reports. As an administrator, you can configure
what columns are displayed and the column arrangement in a rollup report. To do this, you use some
preferences.

Certain columns are available in a rollup report, by default. You must not remove the properties for
these columns from the preferences. However, you can include some additional columns by adding their
properties as values in the preferences.

Use the following preferences to configure a rollup report:

Preference Description
WNB0_MassProp
sColConfiguratio
n

Defines a configuration for the columns that appear in the report that is
generated using the Mass Properties template.

WNB0_MassAndB
alancePropsColC
onfiguration

Defines a configuration for the columns that appear in the report that is
generated using the Mass and Balance Properties template.

While configuring a report, you must specify only the BOM line internal property names and not the
names that are displayed on the user interface.

To get the list of BOM line internal property names:

1. In your BMIDE template project, search for and open the BOMLine business object.

2. Go to the Properties tab.

All BOM line internal property names are displayed in the Property Name column.
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11. Configure the columns to be displayed and their arrangement in a rollup report
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12. Create a structure rollup report
template
To define the standard content of structure rollup reports, you create templates in the rich client.

To create a template, you must be a member of an appropriate group. To create, edit, or delete a Site
template, you must be a member of the DBA group. To create, edit, or delete a Group template, you
must be a member of that same, specific group. You can create, edit, or delete your own user templates.

Note:

A member of the DBA group can create, edit, or delete group or user templates if bypass is turned
on.

To create a structure rollup report template:

1. In the rich client, choose Tools→Rollup Reports→Templates.

2. In the Roll Up Template Manager dialog box, optionally select an existing template in the
Templates list to use as the basis of the new template.

You can select only from the templates that your group has permission to modify.

3. Enter the template name or change the name of the preloaded template. The template name must
be unique within the group.

4. Enter a template description, which Teamcenter uses as the name of the rollup dataset, for
example, <Item_ID> <Rev_ID> <RT_name> <RT_date> <RT_Mass Total>.

5. Check one of the Scope options to indicate which users have access to the template—Site, Group,
or User.

6. Enter a delimiter character to use between data fields if this report is exported to a text file or to an
Excel file.

The default delimiter character is a tab, which works correctly in the case of a text file. However, in
the case of an Excel file, you must change the delimiter character to a comma (,). If you do not do
this, the data columns do not display correctly in Excel.

7. Add or delete Summation, Center of Mass, and Moments/Products calculations for any relevant
structure line property.

8. Add or delete any other properties to include in the rollup report in the Reference box. Referenced
properties are not included in rollup calculations.
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9. Click OK or Apply to save the new template in the database.

Caution:

While creating a rollup report template, if you specify Pack Count (bl_pack_count) as a summation
property, you get correct rollup results for the occurrences only with unpacked structure elements.
Therefore, you must unpack the structure elements and then generate a rollup report to get the
correct number of occurrences.

12. Create a structure rollup report template
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13. Provide access privileges to users for
the weight and balance data
You can restrict access to weight and balance rollup data by configuring the Access Control List (ACL) for
the Wnb0MassMeasurableAttribute and Wnb0MassMeasureValue classes.

For detailed information about setting ACLs, see Access Manager in the Teamcenter help.

1. In Access Manager, navigate to the ACL for the Wnb0MassMeasurableAttribute and
Wnb0MassMeasureValue classes.

2. In the ACL, under POM_object, add the details of the class, attribute, and users as required.

The following examples illustrate how an ACL can be configured to grant access to various user groups
for different weight types:

Example 1

• Grant the user group called Weight Engineer access to all weight types of the classes
Wnb0MassMeasurableAttribute and Wnb0MassMeasureValue.

• Restrict the user group Designer to access only the Asserted weight type.

Class or attribute Role Read Write Create
Has Class(Wnb0MassMeasurableAttribute) Designer Y X X

Weight Engineer Y Y Y
World Y X X

Has Class(Wnb0MassMeasureValue)
Has
Attribute(Wnb0MassMeasureValue:att0Sou
rceType=Asserted)

Designer Y Y Y
Weight Engineer Y Y Y
World Y X X

Has
Attribute(Wnb0MassMeasureValue:att0Sou
rceType=Asserted)

Designer Y X X
Weight Engineer Y Y Y
World Y X X
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The configuration shown in the table does the following:

• The Weight Engineer can create, read, or modify values for all weight types in the
Wnb0MassMeasurableAttribute and Wnb0MassMeasureValue classes, for example, Budgeted,
Asserted, and Evaluated.

• Designers can view or update the Asserted weight type but can only view the other weight types:
Budgeted and Evaluated.

• World (any other user) can only view the values.

Example 2

The configuration shown in the table does the following:

• The Weight Engineer can create, read, or modify values for all weight types in the
Wnb0MassMeasurableAttribute and Wnb0MassMeasureValue classes, for example, Actual,
Asserted, and Evaluated.

13. Provide access privileges to users for the weight and balance data
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• Engineers can view or update the Evaluated weight type but can only view the other weight types:
Asserted and Actual.

• World (any other user) can only view the values.

Weight and Balance Management ─ Deployment and Administration, Teamcenter 2412  13-3
© 2025 Siemens



13. Provide access privileges to users for the weight and balance data
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14. Change the sequence of mass maturity
states for rollup calculations
A rollup calculation selects the mass value based on the maturity assigned to the weight type. For
each BOM line, the mass value from the weight type with the highest maturity is used for mass rollup
calculations.

By default, a certain sequence of mass maturity states is set for rollup calculations. However,
if you want to change this sequence, set the maturity for different weight types in the
WNB0_MassMaturitySequence preference.

In the preference, list the weight types in descending order of maturity you want to assign. The one at
the top of the list is assigned the highest maturity.

In the following example, the highest maturity is assigned to the Actual mass, and the lowest maturity is
assigned to the Budgeted mass.

The following table shows some parts with different mass values. The maturity is assigned as described
in the WNB0_MassMaturitySequence preference example. Based on the maturity assigned to the
weight types, the mass values marked with (✔) are considered for calculating the rollup.

Part Actual (maturity
1)

Asserted
(maturity 2)

Evaluated
(maturity 3)

Budgeted
(maturity 4)

Engine 221 ✔ 225 229 223

Chassis - 421 ✔ 429 423

Wheel
Assembly

- - 29 ✔ 29
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14. Change the sequence of mass maturity states for rollup calculations
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15. Change the CAD application used for
rollup calculations
Teamcenter supports NX and CATIA as the CAD applications for rollup calculations. You can use the
WNB0_TC_CAD_APPLICATION preference to configure the CAD application for your site.

Note:

If no CAD tool is added to the preference, NX is set as the default CAD tool.
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16. Change the default coordinate system
While creating a payload, a business user must define a value for the Center of Mass (CoM). This value
can be CoMx, CoMy, or CoMz based on the specified longitudinal axis.

You can set the longitudinal axis for an excursion diagram by using the WNB0_CoordinateSystem
preference. You can use this preference to define the mapping between the coordinate axes (x,y,z) and
the longitudinal, lateral, and vertical axes. The value for the longitudinal axis in the preference is used in
the column header. The default value is X.

The following image shows some sample values specified in the WNB0_CoordinateSystem preference.
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17. Change the mass types for rollup
calculations
By default, the Actual and Asserted mass types are considered for rollup calculations. However, if you
want Teamcenter to consider other mass types for rollup calculations, add those mass types to the
WNB0_AssemblyMaturedMassTypes preference.

This preference marks the specified mass types as matured. Once the mass types are added, Teamcenter
considers only the mass type of the parent and ignores the sum of the masses of the children for rollup
calculations.

In the following example, the preference defines Actual and Asserted as matured mass types. This
means that if Actual or Asserted mass is available for any parent part in the assembly, its child parts will
be ignored for the rollup calculations.
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18. Define center of gravity and inertia
types for an assembly
As an administrator, you can create custom balance properties. The WNB0_CG_INERTIA_Source
preference controls the custom properties. These custom properties must be a subset
of Wnb0MethodTypeValues. The precedence for these properties is controlled by the
WNB0_MassMaturitySequence preference, which also controls the precedence for mass properties.

This preference defines the Center of Gravity (CG) and inertia types for an assembly. BOM line properties
for Center of Mass (CoM), Moment of Inertia (MoI), and Product of Inertia (PoI) are added based on
these preference values.

If the values for the CAD-driven properties in the WNB0_CG_INERTIA_Source preference are changed,
these changes are not reflected in the template. The template shows the Asserted column with its
internal name and no data. For such cases, either you or the user must create (or update) an Excel
export template with the required properties.
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